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What's New
User Release 3

Warning

This version of HIPE introduces a new indexing format for local stores, with many benefits
including new features and better performance (see Section 14 for more details).

When first executed, HIPE will prompt you to convert your local stores to the new format.
See the Data Analysis Guide for more information, in particular:

• How long the update process might take.

• How to upgrade your local stores manually.

• How to recover from errors in the upgrade process.

Please read the documentation carefully before accessing your local stores. Failure to do
so may result in permanent corruption of your data.

1. Summary
Documentation (see Section 2 for more information):

• Reorganised and shortened two chapters of the Data Reduction Guide.

• Updated and shortened the HIPE Owner's Guide.

• The ordering of manuals in the Table of Contents of the HIPE Help System is now more logical.

• Better structure for the Quick Start Guide and HIPE Owner's Guide.

• Many other fixes and updates to all the manuals.

HIPE (see Section 3 for more information):

• Export/Import session

• Select Window menu

• Reset Perspective menu

• File dumps

• Progress bar

• History persisted among sessions

• More tips and tricks

• Jython editor improvements

TablePlotter and OverPlotter (see Section 4 for more information):

• Introduced configurable APIs support other applications, for example, SpireMask Editor,
DetectorTimeExplorer etc.

• Provided a mechanism to feed back the Bool2d flags

• Extended data type for overlay plot to all types of Ordered1d data

• Validated the input data to prevent from opening an empty HIPE editor
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• Relocated TablePlotter's preference

• Introduced new algorithm for data selection and de-selection

Utilities toolbox (see Section 5 for more information):

• AsciiTableWriter task: option to confirm overwrite

• getObservation and saveObservation functions

• SimpleFitsWriter task: compressed output

Astronomy toolbox (see Section 6 for more information):

• Radial velocity updates

Spectrum visualisation (see Section 7 for more information):

• Improvements to spectrum plot, raster map panel and selection panel

Spectrum toolbox (see Section 8 for more information):

• StitchSpectrum task extended to stitch arbitrary segments

• Fold task now allows variable frequency throws

• In the ResampleFrequency task, the resolution parameter included in the metadata is adjusted

• More flexible specification of segments in the ArithmeticSpectrum task

Data cube analysis (see Section 9 for more information):

• Cube Spectrum Analysis Toolbox

• Main GUI: simplified warning messages on the opening of bad cubes

• Region spectrum extraction: pixel per pixel selection

• Region and spectrum extraction: commands are echoed to the command line

• Spectrum extraction: new zoom mode in the spectrum display

• Spectrum explorer: redesigned the GUI

• Global: cosmetic changes

Herschel Science Archive toolbox (see Section 10 for more information):

• GUI Improvements

• Security enhancements

Herschel Science Archive data pool (see Section 11 for more information):

• HAIO Communication updated.

• Error messages improved.

• Updated exceptions to follow ProductPool interface.

• Added LoginManager listener.

• User-friendly import/export updated.
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• XML request ingestion file is available.

• HsaXmlPool initialisation procedure updated.

Calibration sources database (see Section 12 for more information):

• Planets and moons are separately listed

• Data model revisited

Observation context (see Section 13 for more information):

• Browse product image shown in the outline if available.

• Improved Summary section of Observation Context viewer.

Product framework:

• The product history now shows for all instruments which calibration files have been used during
the processing. You can print a list of tasks and the calibration files used in this task as follows:

# Load some product into the variable -'product'
print product.history

• The results table of the Product Browser perspective is now fully customisable (right-click on any
column header to add and remove columns).

Product Access Layer (see Section 14 for more information):

• Better index format for local stores.

• Pools can now be renamed.

• New rules for pool names.

• Safe recursive removal of Observation Contexts.

• New Urn class and Java query API.

Task framework (see Section 15 for more information):

• Tasks and task parameters warn about invalid names

• Task progress is also shown in HIPE progress bar

• Two-column layout of task panels

• Task panels now generate more compact code depending on used outputs

Source extractor (see Section 16 for more information):

• Extra parameters for DAOPHOT source extractor task

• New "PrfGaussian" class to create Gaussian point response functions

• New methods to perform image operations based on a SourceListProduct

• New constructors for a SourceListProduct or a SourceListDataset

• Optional return values from the source extractor tasks

Numeric library (see Section 17 for more information):

• New delete functionality.
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Quality control framework (see Section 18 for more information):

• Allow custom flags provided by the SPA

Systematic product generation (see Section 19 for more information):

• New property schema for the SPG plugins

• New GUI preferences: processing mode

• Attitude calculations for 'no pointing' AORs

• Integrated headless environment

• New output folders

Installer (see Section 20 for more information):

• A new way to set the java heap size for HIPE has been made available

• A new Proxy Settings Panel has been added

• The Advanced Installation specific settings are displayed in the pre-installation panel

Instrument-specific improvements:

• See Section 21 for HIFI.

• See Section 22 for PACS.

• See Section 23 for SPIRE.

2. Documentation
Data Analysis Guide.

• Thorough revision and reorganisation of the Data input/output, Data display and Image analysis
chapters. The guide is now about 15% shorter due to the removal of duplicated and redundant
material.

• Documented the new PAL browser perspective.

• Updated documentation of the HSA view.

• Corrected section on image smoothing.

• New section on creating spectral cubes.

• Updated sections on accessing the Herschel Science Archive.

• Some fixes to plot chapter.

• Reintroduced section on interoperating with external software.

• Updated section on Spectrum Explorer.

Scripting and Data Mining.

• Added description of debug window in HIPE.

• Added section on product history.
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• Added section on GUI labels of task parameters.

• Added section on importing user-defined modules.

• Documented Singular Value Decomposition and related fitter class.

• Removed some obsolete content.

HIPE Owner's Guide.

• Improved the overall structure of the guide.

• Removed redundant information (the manual is now about 25% shorter).

• Updated most screenshots.

• Included HIPE-IDL comparison sheet.

• Added warning about correct settings of unzipping programs.

• Updated to new PAL Browser Perspective.

• Added information on dump files.

• Improved section on uninstallation.

Other improvements.

• Improved order of the manuals in the Table of Contents of the HIPE Help System.

• Updated the FAQ to the new documentation structure.

• New and improved entries in the FAQ.

• Added hyperlinks to other documents in the Read Me First.

• Improved the structure of the Quick Start Guide.

• Fixed missing figures in Quick Start Guide.

• Updates to instrument guides.

3. HIPE
The following list informs about changes in the HIPE framework. Therefore, it doesn't include
improvements in particular views like the Data Access perspective, image viewers, ICC-particular
tools, etc. For more information about them, please consult their own specific packages.

• Export/Import session

Whole HIPE session can be exported to a file through File → Session → Export. It can be imported

later on in the same or a different HIPE installation, with File → Session → Import. Preferences,
configuration, variables and session customisations can be individually selected to be exported and
imported.

• Select Window menu

Detached views can be shown directly through menu option Window > Select Window.

• Reset Perspective menu
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The current perspective can be restored to its original layout by means of the corresponding option
in the Window menu, which is more visible than the existing way through the perspectives's button's
popup menu.

• File dumps

If HIPE doesn't respond and it is quitted abruptly, a dump file with its state may be generated
(depending on the kill method) under home/.hipe/dumps. Attaching this file to a problem
report can help developers to find the bug.

• Progress bar

When HIPE is working, the throbber icon at the bottom right corner starts spinning. However, it
doesn't inform by itself about the percentage of job already completed. The new progress bar that
has been incorporated at the bottom of the HIPE window is aimed for giving this information.

• History persisted among sessions

You can move around previous executed commands in the Console, with the up and down arrow
keys. In a fresh new session, that list was empty. Since the current HIPE release, commands executed
in previous sessions of this new version are accessible through the up arrow too.

• More tips and tricks

The Tip of the Day window has been enriched with new tips and tricks that you may find useful.
Moreover, previous tips have been revised and updated.

• Jython editor improvements

Script editors have been enhanced in different ways:

• Non saved changes are reflected with an asterisk in the editor tab's title.

• White space characters can be made visible with the corresponding preference.

• Multiline strings are highlighted following the Jython syntax.

4. TablePlotter and OverPlotter
• HCSS-7527 was implemented.

A new algorithm for data selection/de-selection is introduced. In the new algorithm, the X column is
treated as one of the Y columns. Therefore, the two issues mentioned in this HCSS-7527 are solved.

• HCSS-8972 was implemented.

TablePlotter has a new API which allows it to be called with an initial Bool2d flags to indicate
selected/de-selected data points.

• HCSS-8996 and HCSS-9331 were implemented

The default plot symbol for selected data layer in TablePlotter and the first layer in OverPlotter
is vcross.

• HCSS-9079, HCSS-9378 and HCSS-9459 were implemented

TablePlotter has introduced configurable APIs to support other applications. The new APIs allow
the initial column state in TablePlotter to be configurable either to All Columns or Current Cols.

• HCSS-9105
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The overlay feature can be applied to any types of Ordered1d data instead of Double1d only.

• HCSS-9144

TablePlotter introduced a new flag feed-back function. The modified flags can be fed back to the
calling applications.

• HCSS-9281

The TablePlotter's reference has moved to Editors & Viewers category in HIPE.

• HCSS-9411

TablePlotter/OverPlotter now verifies the input data before the HIPE editor is opened to prevent
from opening an empty editor for invalid data.

5. Utilities toolbox
• AsciiTableWriter task: option to confirm overwrite

AsciiTableWriter now provides an option to ask for confirmation if the output file already exists
(parameter name: warn, default: true).

• getObservation and saveObservation functions

Two functions contributed by PACS to simplify the retrieval and storage of observations.

• SimpleFitsWriter task: compressed output

SimpleFitsWriter now allows you to write your FITS file compressed (parameter name:
compression, values: NONE, ZIP, GZIP).

6. Astronomy toolbox
• Radial velocity updates

The LSR definition used has been made consistent with the one used by MPS. Radial velocity offers
functions and task in different classes: Java functions are in RadialVelocity and the task in
RadialVelocityTask. Documentation has been updated too.

7. Spectrum visualisation
Spectrum plot:

• Visualise flags

• Display mouse cursor channel/flag information

• Display row/column instead of row/segment information for cubes

• Flag menu provides instrument-specific flags

• Apply tasks from within Observation viewer

• Added setLineColor() to add multiple spectra in same colour

Raster map panel:
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• Added location view

• Display sky location on mouseover

Selection panel:

• Show progression when loading HifiTimelineProduct

• Improved filter panel to easily select and display specific spectra

8. Spectrum toolbox
• Extension of StitchSpectrum task: The value stitchAll for the variant parameter is added

which allows to stitch arbitrary segments and point spectra included in SpectrumContainer into a
single point spectrum.

The result will be again a SpectrumContainer containing just a single point spectrum.

• The fold task is extended so that variable frequency throws are allowed now. This was a
requirement by HIFI.

• In the ResampleFrequency task, the resolution parameter included in the meta data is adjusted.
Actually, a modified version of it, resolution_resampled, is added.

• The ArithmeticSpectrumTask which is used e.g. in add, subtract, divide, multiply, extract, select
allow for more flexible specification of "segments" to be selected. For example, segment=[2,4]
used in the extract-task will extract the segments with ids 2 and 4.

• Series of bug fixes:

• SmoothSpectrum: SmoothSpectrum fails for HIFI HEB spectra.

• ExtractFreqRanges: Creating a spectrum1d from spectrum explorer fails.

• Statistics task: Statistics task crashes with a NullPointerException when used on specific datasets
in an HEB observations.

• Problem with resampling caused by NaN's in the wave scale after average: ResampleFrequency
failure on averaged spectrum: IndexOutOfBoundsException.

• NaN creation (in ResampleFrequency task).

9. Data cube analysis
• CubeSpectrumAnalysisToolbox (main GUI):

A new mode is available in the region and spectrum selection and extraction mode: pixel per pixel,
which allow you to select pixels one by one, and therefore to define custom shapes, even a non
contiguous set of pixel.

Renamed some buttons

Standardised the units on the intensity axis of spectrum plots

• Spectrum and region extraction: commands are echoed to the command line

when you click on Save product, a set of lines is sent to the Console, reproducing the command to
launch the same task with the same parameters. You can then reuse and modify these lines in your
scripts. it create also for region mode an array of pixel to be used for the call of the task. This new
behaviour can be deactivated.
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• Spectrum extraction: new zoom mode in the spectrum display

By default the spectrum shown in the single spaxel extraction GUI is set to an autoscale zoom level.
You can select a new check button to define your own window (by dragging on the plot window)
and keep it for the whole selection process. This can be also deactivated.

• The spectrum explorer GUI was redesigned with the following improvements:

• The panel for the spectral simple cube has a scroll bar and show its content whatever the initial
size of the panel

• The zoom panel is located on the right of the cube panel, so it does not hide part of the cube
anymore.

• The initial zoom factor is fitted to the window's size.

• Default selection mode is single pixel and there is no pop up window asking to choose a selection
mode.

The various tasks of the Spectrum Toolbox are now compatible with decreasing spectral values order
(like HIFI's low side band)

• All tasks: CDELT3 < 0 supported and additional tests added.

the whole toolbox can work on decreasing cubes, and some additional test have been added on
the features using "spectral domains" to be sure the limits are well defined in the case of negative
CDELT3.

10. Herschel Science Archive toolbox
• Following user feedback, we implemented several GUI improvements. The HSA Perspective was

optimized to reduce the number of clicks required to work with data in the HSA.

The Save Products View can be used to save observations locally, that are retrieved from the HSA
using direct retrieval (the "Send to External Application" button in the HSA User Interface). This
save process will now run in the background, allowing you to run other tasks in HIPE while saving
is ongoing.

• Several security issues have been identified and fixed. Automatic log-in in the HSA User Interface,
when starting it from HIPE, had been disabled in 2.0, because the mechanism was found not be
secure. A secure mechanism has been implemented and the automatic log-in has been re-enabled.
Similarly, logging in using the HIPE GUI now uses an encrypted connection for sending log-in data.

11. Herschel Science Archive data pool
• HAIO Communication updated.

Added HTTP POST requests and SAX parser.

• Error messages improved.

Exceptions have been added in order to show HAIO error messages.

• Updated exceptions to follow ProductPool interface.

ProductPool interface has been updated. HsaPool has been updated also in order to provide the
suitable exceptions specified by ProductPool.

• Added LoginManager listener.
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HsaPool will receive LoginManager notifications related to login/password modifications.

• User-friendly import/export updated.

Import/export mechanism will try a LocalStore directory structure as default. This will fix a problem
when sharing LocalStore's when the import/export functionality is involved related to product file
paths.

• XML request ingestion file is available.

Access to an XML request ingestion file is available through HsaPool.

• HsaXmlPool initialisation procedure updated.

HsaXmlPool will create a list of URNs at initialisation time. This will improve the performance
when retrieving/asking for products.

12. Calibration sources database
New features available:

• Planets and moons are now listed separately.

The main Calsdb window previously contained two lists of objects: Solar system objects (SSOs)
and astronomical sources. We have now taken planets and their moons out of the list of SSOs and
given them their own table. The table with astronomical sources was relabelled "fixed targets".

• Data model revisited.

• The way the data in the Calsdb is stored in FITS files (this is called the data model) has been
revisited. The previous model leads to an excessive number of very small files. The change is to
store information about the flux from an SSO on a particular operational day inside the FITS file
that holds the other information about the SSO. This file is now larger than before, but still very
manageable (about 1 MB).

13. Observation context
New features available:

• Browse product image shown in the outline if available.

When a variable holding an observation context is selected, the outline prints its browse product
image, if existing.

• Improved Summary section of Observation Context viewer.

• The target object is included in the summary

• RA is shown in hours, minutes and seconds

• DEC is shown in degrees, minutes and seconds

14. Product access layer
• New local store index format.

The new internal index format has several advantages, among which:
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• Improved query performance

• Renaming of pools now possible

• Implement safe deletion of an entire context

• Renaming pools.

You can rename pools created with HIPE 3.0 and higher. This does not work with pools created
with earlier versions, even if you have updated them to the new index format.

• New rules for pool names.

Pool names now accept only letters, numbers, dot and underscore characters.

• Safe recursive deletion of a context.

The new method ProductStorage.remove(urn, recursive) can be used for safe
recursive removal of Observation Contexts. Products referenced by other contexts are not deleted.

• Other API changes.

Only relevant for developers and advanced users: introduced a Urn class and a new Java query API.

15. Task framework
Task is being updated to improve the following areas: better usability, better developer support, better
integration with HIPE and updated documentation.

New features available:

• Tasks and task parameters warn about invalid names

This improvement is in the area of better developer support. If a task is given a name that does
not follow the conventions, an info log message is issued. If a task parameter is given a name that
cannot be parsed successfully by Jython a warning log message is issued.

• Task progress is also shown in HIPE progress bar

This improvement is in the area of better integration with HIPE. Whenever a task is executed, the
HIPE progress bar is updated to reflect the task name and progress of the current task.

• Two-column layout of task panels

This improvement is in the areas of better usability and better integration with HIPE. To reduce
wasted screen space and to improve the usability of tasks with lots of parameters, the default task
panel now layouts parameters (both inputs and outputs) in two columns.

• Task panels now generate more compact code depending on used outputs

This improvement is in the area of better usability. If the execution of a task does not generate values
for some outputs, those outputs will not be assigned to user variables. This reduces the lines of code
generated and the number of variables used without changing the behaviour of the code.

16. Source extractor
New features available:

• Extra parameters for DAOPHOT source extractor task
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The DAOPHOT source extractor task now has optional user parameters to specify radii for aperture
photometry and background estimation as well as limits in roundness and sharpness of sources.

• New "PrfGaussian" class to create Gaussian point response functions

A new class has been provided enabling the easy creation of an image of a point source, or any
number of point sources, based on a Gaussian profile, with arbitrary width, normalisation and
position.

• New methods to perform image operations based on a SourceListProduct

Based on the PrfGaussian class, new methods have been added to the SourceListProduct making it
possible to create an image of the source in the source list, or to add or subtract the sources from
an existing image.

• New constructors for a SourceListProduct or a SourceListDataset

Various constructors have been added to enable easy creation of a SourceListProduct or a
SourceListDataset given an array of coordinates (ra, dec) and (optionally) fluxes. For example,
sources = SourceListProduct(ra, dec).

• Optional return values from the source extractor tasks

New parameters "getPrf" and "getFilteredMap" have been provided for the source extractor tasks
to return the PRF and/or the filteredMap in addition to the source list.

• Bug fix: error map for returned beam-filtered map from SUSSEXtractor source extractor

When the beam-filtered map is requested from the SUSSEXtractor source extractor, the "error"
image in the filtered map previously had null values in many pixels. This has now been fixed.

• Bug fix: wrong fluxes when image has units of "Jy"

When the input image had units of "Jy" (meaningless, since "Jy" is a unit of flux density, not surface
brightness), the returned fluxes were seriously wrong. An error message is now raised when the
input image does not have units of surface brightness.

• Bug fix: confusing error message when SUSSEXtractor was attempted on an image without an
"error" image.

SUSSEXtractor requires an image with an "error" image. When this is not the case, the task now
fails with a helpful error message, identifying the source of the problem.

• Documentation

Various improvements have been made to the documentation for this module.

17. Numeric library
New features available:

• New delete functionality.

Data arrays allow elements removal

18. Quality control framework
New features available:
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• Custom Quality Flags

SPA will now be able to create on the fly new quality flags not previously defined. This feature
will serve for any kind of flags: Simple ones or those with a value attached. This is, in any case, a
temporal solution for those flags missed from the quality framework.

19. Systematic product generation
New features available:

• New property schema for the SPG plugins

SPG plugins will now be split in four different properties: hcss.ia.pg.common and
hcss.ia.pg.instrument (one per instrument) This will allow the instrument developers to
define they own plugin properties

• New GUI preferences: processing mode

User will now be able to define the default processing mode for a new SPG session using
the new input parameter: pipeline_manager -mode=SYSTEMATIC|BULK_REPROCESSING|
ON_DEMAND (valid also in lower case)

• Attitude calculations for 'no pointing' AORs

Observation regarding moving targets will contain a NAIFID and no ra/dec nominal values. This
case should be solved setting nominal ra/dec using the values extracted from pointing data and stored
in av ra/dec fields. Engineering observations with dummy ra/dec in the original request. Dummy
values (ra=dec=0.0) should be identified and replaced by the values from the pointing data as in
the previous case. When the first observations of an OD are no-pointing. Use the first pointing data
available for that OD as the current s/c attitude without SIAM correction. Here we must take into
account that the maximum error in the position of the s/c for a complete OD where no new pointing
commands are issued is of 0.47 arcsec.

• Integrated headless environment

pipeline_daemon can now work silently in a headless environment without the need to specify any
JVM property.

• New output folders

New folder for output files is now dependent of the od number being processed for SYSTEMATIC
and BULK reprocessing:

• SYSTEMATIC PIPELINES: ./output/systematic/odNumber

• BULK REPROCESSING PIPELINES: ./output/bulk/odNumber

• ON DEMAND PIPELINES: ./output/on-demand

• OPERATIONAL DAY PLUGINS: ./output/od

20. Installer
• The way that the user installer sets the java heap size for HIPE has changed. If in the hipe.props

file the java memory size IS NOT defined (or the file does not exist in the ${USER_HOME}/.hcss
directory) then the installer will write in the file ${installation_directory}/installed.properties the
selected heap size (or 1 GB if the user has chosen the basic installation and therefore doe not have
the option to select the memory). If in the hipe.props file the java memory size IS defined then
this value will be the proposed value in the advanced settings panel and if the user chooses a new
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value then the new value will be written in the hipe.props and in the ${installation_directory}/
installed.properties. Memory settings in the file USER_HOME/.hcss/user.props are considered
illegal and will be patched by the installer as it is already done for other variables (e.g database
settings)

• A new panel has been created so that you can provide proxy specific settings. The information to
be provided consists of the host, the port, the proxy user and the corresponding password.

• When you choose the Advanced instead of Basic installation, all the provided information in the
extra steps are displayed in the pre-installation panel.

21. HIFI
Mapping

• Secondary output of DoGridding and Gridding: a MapContext with the result cubes

Since these tasks can run for several subbands in parallel, producing a cube per [specified] subband,
the output is usually an array of cube products. For convenience to the end user, a secondary output
has been added to these tasks, a MapContext filled in with these cubes, having convenient key
names within the context so that it is straightforward to identify to which back end, side band, and
subband corresponds each cube, and so that the user can directly explore this result by means of
the Context explorer to visualise directly any of these cubes in a suitable viewer for cubes, without
having to create an specific cube variable by indexing certain element of the result array of cubes.

• GriddingTask renamed simply as Gridding.

The GriddingTask has been renamed as 'Gridding' in order to follow the Task naming rules, which
require that the 'Task' word is not appended as a suffix to the task names.

FitFringe

• x-axis plots in MHz if MHz button enabled.

• Consistent labelling and colours in different plots.

FitHifiFringe

• Accepts ObservationContexts, HifiTimelineProducts, and SpectrumDatasets as input.

• More user-friendly input parameter names: start_period, end_period, typical_period.

• User can define masks in addition to automatically determined masks.

Generic pipeline

The velocity correction has been moved from the level2 to the level1 pipeline which means that already
the level1 products are corrected for the spacecraft velocity; nevertheless, it is still expressed at the IF
scale. Furthermore, a relativistic formula is applied to do the correction whereas in the previous version
a linear Doppler formula was used. A new task DoVelocityCorrection has been introduced for that.

The level1 and level2 pipeline scripts (Level1PipelineAlgo, Level2PipelineAlgo) have been
simplified.

Refactoring of the calibration data: As part of a general effort to refactor the HIFI calibration data
changes were needed in the way these products are accessed and used from within the level1 and
level2 pipelines while retaining backwards compatibility.

The way how calibration data can be provided to the tasks has become more simple: Just pass the
calibration context included in the observation context. Make sure that during the processing of the
tasks within the pipeline the chopper positions are properly initialized.
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Further changes

• The LO throw is now a quantity that is defined on a per scan basis.

• A parameter "frequencyWidth" is added to the meta data after resampling to a linear grid.
Furthermore, the resolution parameter is adjusted - or, more precisely, a new parameter
resolution_resampled is added with the adjusted resolution of the spectra.

• Automatic import and instantiation of the task DoFold - it appears in the "applicable" menue under
the name "doFold".

• A Stitch task (DoStitch) which works on HifiTimelineProduct's has been added. An instance of this
task appears under "applicable" in HIPE ("doStitch").

Further bug fixes

• Check phases - phases table allows different number of LO frequencies: "Pipeline generates an
exception in 1342190840 at checkphases".

• Extending the validity of the OBS patch for FastDBS modes: "Negative line fluxes again".

Pipeline utilities

Some changes needed to reduce the number of products included in a HifiTimelineProduct.

Some problems in the HIFI specific version of the SelectSpectrum-task fixed
(herschel.hifi.pipeline.util.tools.SelectSpectrum).

Furthermore, this task allows to add meta data found in the datasets of the input HifiTimelineProduct
when asking for an output as a single dataset (using 'add_from_metadata').

22. PACS
Spectrometer

• Flux calibration:

No change: the ground RSRF and nominal response calibration files are still used.

• Wavelength switching:

The pipeline is released. Reductions are to first, for each spectral line, subtract the continuum.
Then a differential frame is generated using pairwise differences. The resulting curve is fitted and a
synthetic cube is reconstructed using the fit result. The synthetic and the measured cube are rebinned
and projected on the sky to yield the final level 2 product.

• Projection:

specProject has a better flux conservation handling; WCS corrected for mirroring; better handling
of the flux normalisation when combining rasters; Ra and Dec Offset of specProject maps have
been fixed.

Photometer

• Flux calibration:

Responsivities version 5 result from a large scale calibration exercise using actual astronomical
standards. They are meant to be used with version 3 of the photometer flat field product with no gain
drift correction - task photDriftCorrection should not be run. The resulting photometric accuracy
(on point sources, with aperture correction) is better than 5%.

• Bad pixel mask:
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Added bad pixel [2,30] to create V4 of the bad pixel mask.

• Projection:

• PhotProject option optimizeOrientation works now also at high dec; photProject and
photProjectPointSource have options for correcting telescope rotation angle; improved projection
of pointSource observations.

• A graphical tool to analyse MapIndex objects is in prototype state. A task to call it is
herschel.pacs.spg.phot.MapIndexViewerTask. The task is available in HIPE as mapIndexView.
It needs a Frames object and a MapIndex as minimum input. Best is also to add a map.

HIPE> from herschel.pacs.spg.phot import MapIndexViewerTask
HIPE> mapIndexViewer = MapIndexViewerTask()
HIPE> map = photProject(frames)
HIPE> mapindex = mapindex(frames)
HIPE> #
HIPE> # alternative calculation for the mapindex:
HIPE> # photProject(frames, deglitch = True)
HIPE> # mapindex = photProject.getValue("index")
HIPE> #
HIPE> mapIndexViewer(mapindex, frames, map) #invokes the viewer
HIPE> mapIndexViewer(mapindex, frames) #invokes the viewer with on-the-fly 
calculation of the map

• A new Wcs4MapTask externalises the WCS calculation for photometer maps. This allows
scientists to get a WCS, modify it according to their requirements and pass the modified WCS
to PhotProject. The task is available from HIPE as wcs4map. This modified product replaces the
mapcoordinates parameter in PhotProject.

• The MapIndex can be stored as FITS.

• A graphical tool to analyse MapIndex objects is in prototype state. The task to call it is
herschel.pacs.spg.MapIndexViewerTask. The task is available in HIPE as mapindexview. It
needs a Frames object and a MapIndex at minimum. Best is also to add a map.

• Madmap is currently offered as an interactive tool until a robust goodnees-of-fit estimator for
baseline fits is available. It is possible to combine scan and cross-scan observations. There are
now two new tasks that remove both module and global drifts: PhotGlobalDriftCorrectionTask.py
and PhotModuleDriftCorrectionTask.py which can be used before calling Madmap. In fact, it is
highly recommended to pre-process the data before calling Madmap.

• Deglitching:

• MMT deglitching can either fix the signal or produce only a glitchmask; it accepts a sourcemask
as input.

• Second level deglitching (IIndLevlDeglitching) accepts masked region of interest more complex
than a square; it allows sigma clipping on the map pixel realisations, rather than on the cube pixel
values. The option for this is deglitchvector = "timeordered".

Common to spectrometer and photometer

• Pointing:

• Added instant pointing to work on a Ramps level

• Angular velocity is added to Frames Status in the task [phot|spec]addInstantPointing

• Photometer processing for solar system objects (SSO) included

• An improved method for computing the pointing aberration
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Other improvements

• MaskViewer:

The MaskViewer has been updated and has a new overplotter for the complete status table.

• Framework:

New convenience functions: getObservation and saveObservation

• New Button in HIPE -> Pipeline:

Currently this link point to the ipipe pipeline scripts. This scripts also serve as reference for standard
pipeline processing.

• The new sliced ipipe scripts. These scripts are not yet used in the automatic pipeline, but will be
used after some validation period.

Spectroscopy (ready): chopNodStarL1.py, offMapL1.py, rampsL05.py, waveSwitchL2.py,
chopNodStarL2.py, framesL05.py, offMapL2.py, waveSwitchL1.py.

Photometry: framesL05.py, pointSourceL1.py, pointSourceL2.py, scanMapL1.py,
scanMapL2.py, scanMapSimpleL1.py, scanMapSimpleL2.py, smallSourceL1.py,
smallSourceL2.py.

• The old style (non sliced) processing scripts. These scripts contain the same steps as the automatic
pipeline, just in a form to be executed step by step.

Spectroscopy: pacsspecchopnodstarrampsIA.py, pacsspecchopnodstarframesIA.py,
pacsspecoffmapIA.py, pacsspecwaveswitchIA.py.

Photometry: pacsphotscanmapsimpleIA.py, pacsphotpointsourceIA.py,
pacsphotsmallextendedIA.py, pacsphotscanmapIA.py.

• We are just evaluating how to add more useful scripts here, for instance for specific source types,
fluxes and so on.

23. SPIRE
Calibration products

There are new products of:

• SCalSpecBsmPos

• SCalPhotBsmPos

• SCalSpecFluxConv

• SCalPhotChanNoise

• SCalPhotBeamProf

• SCalSpecInterRef

Summary of changes:

• Allow calibration of positions in spectrometer mapping observations.

• Allow good calibration of different spectrometer resolutions (better removal of fringes).

• Allows use of mad map for photometer.
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• Allow release of SOF1 MR mode.

• Improve consistency for product types.

Calibration framework

• Beam profiles now have a specialised class extending the previous SimpleImage.

• New "astronomer" task SpireCalTask for getting a calibration tree into HIPE.

• Several improvements to the user-friendliness of the CalImport tool.

• Spectrometer Flux Conversion file now depends on spectral resolution and apodization function as
well as time and bias mode.

Preprocessing

• New format for level 0 products: the raw data are stored now in a single level 0 product for each
building block instead of being split also by telemetry type

• Compulsory metadata now copied also in level 0 context

Engineering conversion

• Support new format of level 0 products

• Implemented new task for masking telemetry parameters MaskTmParamTask

Common pipeline

• Improved performances of AssociateSkyPositionTask

• Changed parameter names for JoinPhotDetTimelinesTask and JoinNhkTimelinesTask
(SPIRE-2359): the new names are leading (old trailing) and trailing (old following)

Photometer pipeline

• The detectors signals is now in float instead of double precision in level 1 product

• POF5, PARALLEL and POF10 pipelines can be executed excluding map making by setting
input.mapping="none"

Spectrometer pipeline

• First-level deglitching, with an improved reconstruction method, has been re-introduced to the
spectrometer pipelines.

• Many improvements have been made to the spectrometer pipeline modules with respect to
monitoring of quality control (QC) metrics. This has including adding functionality to track certain
metrics as well as improvements to the thresholds of existing metrics. Most notable among these
improvements has been:

• Monitoring of the status of the mode of Spectrometer Mechanism. A QC metric has been added
to check whether the Spectrometer Mechanism dropped out of Closed Loop mode.

• Monitoring of the status of Baseline Correction module. QC metrics have been added to check
how well the offset subtracted performed.

• Monitoring of the instrument temperatures over the course of an observation. The thresholds for
this QC metric have been improved based on a reanalysis of the Flight data.

Interactive analysis and tools
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• herschel.spire.ia.dataset.gui decoupled from herschel.spire.ia.dataset: a new package called
herschel.spire.ia.gui has been created

• New layout for DetectorTimelineExplorer and DetectorTimelineExplorerComponent (DTE) was
implemented: removed metadata panel, all the control (slider, menu to select dataset and array,
checkbox, etc) are now grouped in the bottom side, the "Quick View" area is now larger than
previous version

• New method to launch DTE from HIPE command line

• New DTE option that allows creation of mask over-plot

• New class called TimelineSimplePlot allows to create simple SPIRE Detector Timeline plots from
HIPE command line

• New GUI tool called SpireMask Editor is implemented (SPIRE-2119)
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